
© KernelApps Private Limited

PRODUCT GUIDE 



© KernelApps Private Limited

Table of Contents 

1. Introduction to Kernel for ZIP ........................................................................................................................................ 4 

1.1 Using this Manual ................................................................................................................................................... 4 

1.2 About Kernel for ZIP .............................................................................................................................................. 5 

1.3 Salient Features ....................................................................................................................................................... 5 

1.4 Who Should Use this Software? ............................................................................................................................. 5 

2. Getting Started ................................................................................................................................................................ 6 

2.1 Installation Pre-requisites ........................................................................................................................................ 6 

2.2 Downloading Kernel for ZIP for the First Time ..................................................................................................... 7 

2.3 Install Kernel for ZIP .............................................................................................................................................. 7 

2.4 Start Kernel for ZIP................................................................................................................................................. 7 

2.5 Uninstall Kernel for ZIP ......................................................................................................................................... 7 

3. Software Interface ........................................................................................................................................................... 9 

3.1 Menu-bar ................................................................................................................................................................. 9 

3.2 Tool-bar ................................................................................................................................................................. 10 

3.3 Status Bar .............................................................................................................................................................. 11 

3.4 Buttons Used ......................................................................................................................................................... 11 

4. Repairing ZIP Files ....................................................................................................................................................... 13 

5. Full Version .................................................................................................................................................................. 16 

5.1 Requirement of Full Version ................................................................................................................................. 16 

5.2 Purchasing Full Version ........................................................................................................................................ 16 

6. Support .......................................................................................................................................................................... 17 

7. Troubleshooting ............................................................................................................................................................ 18 

7.1 Common Issues ..................................................................................................................................................... 18 

7.2 Frequently Asked Questions ................................................................................................................................. 18 

8. Legal Notices ................................................................................................................................................................ 19 

8.1 Copyright .............................................................................................................................................................. 19 

8.2 Trademark ............................................................................................................................................................. 19 

8.3 Disclaimer ............................................................................................................................................................. 19 

8.4 License Agreement ............................................................................................................................................... 19 



© KernelApps Private Limited

Table of Figures 

Figure 3.1: File Menu ............................................................................................................................................................. 9 

Figure 3.2: Tools Menu ........................................................................................................................................................... 9 

Figure 3.3: Help Menu .......................................................................................................................................................... 10 

Figure 3.4: Status Bar ........................................................................................................................................................... 11 

Figure 4.1: Main Window ..................................................................................................................................................... 13 

Figure 4.2: Selected ZIP file ................................................................................................................................................. 14 

Figure 4.3: Recovered ZIP file data ...................................................................................................................................... 15 



© KernelApps Private Limited

1. Introduction to Kernel for ZIP

Welcome to the user manual for Kernel for ZIP, the most effective and convenient zip file repair tool 
available that repairs and fixes corrupted ZIP files. This user manual comprises step by step guidelines on 
using Kernel for ZIP. 

1.1  Using this Manual 

This user manual is intended to guide users on using Kernel for ZIP. We suggest that first time users 
should read this user manual completely and carefully before proceeding to use the software. However, if 
you are an experienced user, you can use the table of contents to find out information pertaining to the 
tasks that you need to perform by using Kernel for ZIP. 

You can use the table of contents to navigate through different sections of this user manual. The table of 
contents lists all the sections that are contained in this user manual in chronological order. The user 
manual comprises the following sections: 

 Introduction

 Getting Started

 Software Interface

 Repairing ZIP Files

 Full Version

 Support

 Troubleshooting

 Legal Notices

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

1.1.1 List of Abbreviations 

CRC: Cyclic Redundancy Check 

MS: Microsoft 

RAM: Random Access Memory 

MB: Mega-Byte 

GB: Giga-Byte 
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1.2 About Kernel for ZIP 

Kernel for ZIP is a file recovery tool that recovers files from corrupted ZIP archives which gets corrupt due 
to incomplete download, virus attacks or CRC errors. 

You might be familiar with the following error messages if you have encountered ZIP file corruption before: 

 File is corrupted, WinZip cannot open it

 Cannot open file: it does not appear to be a valid archive

 General Input/output error

Kernel for ZIP uses quick algorithm for searching and repairing corrupted ZIP files and hence is fast, 
simple and easy to use ZIP file repair software, which helps you to recover and repair your corrupt zip 
archive files in minutes. 

1.3 Salient Features 

Salient features of Kernel for ZIP include: 

 Efficient embedded repair algorithms to quickly repair corrupt ZIP archives

 Repair broken .zip files, giving CRC errors

 Recovers password protected ZIP files of version "Zip2.0 Compatible encryption (Portable)"

 Support for all versions of ZIP files

 User friendly graphical user interface

 Free demo to experience features and functions of the tool before purchasing it

1.4 Who Should Use this Software? 

The capability of Kernel for ZIP to repair corrupt .zip files makes it appropriate for use by professionals, 
home users, organizations, who have encountered ZIP file corruptions. This corruption could have been 
caused due to virus attacks, CRC errors, broken download etc. 
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2. Getting Started

Now that you have understood the features and potential of Kernel for ZIP, you are ready to get a hand on 
experience of the software. To start repairing .zip files, you will first need to download and install this 
software. 

It is strongly recommended that before installing Kernel for ZIP, you should go through the installation pre-
requisites for the software to ensure that your computer is appropriately configured to run the software. 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for ZIP can be broadly classified into two major 
categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium Class Processor

 Minimum 64MB RAM (128 MB recommended)

 10MB for Software installation

 Disk Space - Enough space to store the repaired files

 You should have at-least 40 MB of free disk space if you want to repair and save a 
40 MB .zip file. 

2.1.2 Software Requirements: 

The software requirements for installing the software can further be grouped into two categories – 
Operating system requirements and ZIP file version requirements. The requirements are as follows: 

2.1.2.1 Operating System Requirements 

Supported Operating Systems: 

 Windows Vista

 Windows XP

 Windows 2003

 Windows 2000

 Windows Me
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 Windows 98

2.1.2.2 ZIP file Version Requirements 

Supported ZIP file versions: 

 All versions of ZIP files compressed with ZIP compression utility

2.2 Downloading Kernel for ZIP for the First Time 

After checking your computer with the prescribed system requirements for Kernel for ZIP, you can 
download and install the software on your computer. You can buy the full version of the software from any 

one of our authorized resellers– Element5, Asknet and 2CO. 

If you want to try using Kernel for ZIP before buying it, you can download the evaluation version from the 
following link: 

https://www.nucleustechnologies.com/Corrupted-Zip-File-Repair-Software.php

 You can repair .zip files saved on your system by using the evaluation version of 
Kernel for ZIP, however, the repaired file will not be saved until you purchase the full 
version of the software. 

2.3 Install Kernel for ZIP 

After downloading the installer file for Kernel for ZIP, you can install the software by running the file. To 
install Kernel for ZIP: 

1. Double-click the Kernel for ZIP installer. Follow the on-screen instructions. The Setup Installation
Complete screen will be displayed.

2. Click Finish to launch the software.

2.4 Start Kernel for ZIP 

To start Kernel for ZIP: 

Click the Start  All Programs Kernel for ZIP 

Alternatively, you can launch Kernel for ZIP by double-clicking the shortcut icon available on the Desktop 
and Quick Launch icon. 

2.5 Uninstall Kernel for ZIP 

You may need to uninstall and re-install Kernel for ZIP. To uninstall Kernel for ZIP: 

1. Click the Start  All Programs Kernel for ZIP  Uninstall Kernel for ZIP

A warning message will be displayed. 

http://www.nucleustechnologies.com/Download-ZIP-File-Repair-Software.php
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2. Click ‘Yes’ to uninstall Kernel for ZIP.

 Before proceeding to uninstall Kernel for ZIP, you must ensure that the software is 
not running. 

You can alternatively uninstall Kernel for ZIP from the Control Panel by performing the following steps: 

1. Click the Start Menu  Control Panel and then double click the Add or Remove Programs icon.

2. Select Kernel for ZIP and click Remove. A warning message will be displayed.

3. Click Yes to uninstall Kernel for ZIP.
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3. Software Interface

Now that Kernel for ZIP has been installed on your computer, you can start using the software after getting 
acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for ZIP comprises three main menus – File, Tools, and Help. 

3.1.1 File Menu 

The File menu comprises three menu items. 

Figure 3.1: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Add Select to add corrupt .zip file(s) 

Save Select to save the repaired .zip File(s) 

Exit Select to close the software 

3.1.2 Tools Menu 

The Tools menu comprises two menu items. 

Figure 3.2: Tools Menu 

Menu items in the Tools menu: 
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Field Name Field Description 

Setting Select to configure file name prefix 

Live Update Select to update current software with the latest 
version available on the internet 

3.1.3 Help Menu 

The Help menu comprises three menu items. 

Figure 3.3: Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Help Select to get user guide of Kernel for ZIP 

About KernelApps ZIP Select to view version-related and support information of 
Kernel for ZIP 

Software Home Page Select to visit the homepage of the software 

3.2 Tool-bar 

The tool-bar in Kernel for ZIP is displayed below the menu-bar. The tool-bar provides a convenient and 
user-friendly method to perform certain actions that can also be performed by using the menu-bar. Read 
the information in the table below to find out about the tool-bar buttons: 

Button Button Name Button Description 

Add Files Click to add corrupt .zip file 
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Repair Files Click to repair corrupt .zip file 

Save Files Click to save the repaired file 

Settings Click to change the prefix of the repaired file 
name 

Live Update Click to update current software with the latest 
version available 

Buy Online Click to buy the software online 

3.3 Status Bar 

Status bar is displayed at the bottom of the software window. The text ‘Ready’ is displayed on the status 
bar if Kernel for ZIP is ready to be used. Status bar also displays the text ‘CAP’, ‘NUM’, ‘SCRL’ which 
respectively correspond to the Caps Lock, Num Lock, and Scroll Lock keys on your keyboard. If any of 
these keys are pressed, the color of the corresponding text will turn blue/black. 

Figure 3.4: Status Bar 

3.4 Buttons Used 

Apart from the standard options available in the menu-bar and the tool-bar, following are the main buttons 
that are displayed on the main window. 

Click to browse and select the .zip file that needs to be repaired 
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Click to start the repairing process 

Click to go back to the main window of software 

Click to stop the searching process 
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4. Repairing ZIP Files

Now that you have complete familiarity of the user interface of Kernel for ZIP, you are ready to repair .zip 
files. To repair .zip files: 

1. Launch Kernel for ZIP.

Figure 4.1: Main Window 

2. Click the Add Files button from toolbar or Browse to browse and list corrupt ZIP file. 

3. If the corrupt ZIP file is password protected, provide the password.

 The software only repairs the password protected zip file version of "Zip2.0 
Compatible encryption (Portable)" 
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Figure 4.2: Selected ZIP file 

4. Select the Repair Files button from toolbar or click Next  to start the repairing process. Now the 
software starts the repairing process and shows the recovered data. 
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Figure 4.3: Recovered ZIP file data 

5. Select Save Files button from toolbar to save the repaired files at the desired location.

A dialog box named ‘Save Options’ appears which asks for the saving format either to save in Normal 
format or in Zipped format. 

6. Select the appropriate option and click OK.

 By default, the names of the repaired .zip files will be the original file name prefixed 
by the text ‘Rep’. However, you can change the prefix by clicking on the Settings 

option in toolbar. 
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5. Full Version

Although you can use Kernel for ZIP evaluation version for free and experience the capabilities of the 
software but there are certain features that are not available in the evaluation version. 

5.1 Requirement of Full Version 

By using the evaluation version of Kernel for ZIP, you can repair corrupt .zip files; however, you cannot 
save the repaired files. 

You will need to buy the full version of the software to save the repaired .zip file. 

5.2 Purchasing Full Version 

You can buy the full version of Kernel for ZIP from any one of our authorized resellers – Element5, Asknet 
and 2CO. 

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email 
comprising the URL to download the full version of Kernel for ZIP and activation details of the software. 
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6. Support

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for ZIP. The software comes with an embedded help manual that can be 
accessed by clicking Help Help in the menu-bar. You can also press the F1 key on the 
keyboard of your computer to access the embedded help of Kernel for ZIP. 

We also have live support wherein you can chat with our software experts at 

https://www.nucleustechnologies.com/supportcenter/

To talk on phone with our software experts call: 

Help line:  

+91-9818725861

1-866-348-7872 (Toll Free for USA/CANADA)

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

https://www.nucleustechnologies.com/supportcenter/
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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7. Troubleshooting

This section deals with your generic and specific queries pertaining to using Kernel for ZIP. 

7.1 Common Issues 

Why does Kernel for ZIP have limitations in evaluation copy? 

The free evaluation version of Kernel for ZIP is intended to enable you to experience the capabilities of the 
software. You will need to buy the software to save the repaired zip files. 

7.2 Frequently Asked Questions 

How to Buy Kernel for ZIP? 

You can buy Kernel for ZIP online at https://www.nucleustechnologies.com/Buy-ZIP-File-
Repair-Software.php  

I have lost my full version for Kernel for ZIP. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 

https://www.nucleustechnologies.com/Buy-ZIP-File-Repair-Software.php
http://www.nucleustechnologies.com/Buy-ZIP-File-Repair-Software.php
mailto:sales@nucleustechnologies.com


© KernelApps Private Limited

8. Legal Notices

This section comprises the legal specification about Kernel for ZIP and the company KernelApps 
Private Limited 

8.1 Copyright 

KernelApps Private Limited, KernelApps accompanied user manual and documentation are copyright of 
KernelApps Private Limited, with all rights reserved. Under the copyright laws, this user manual cannot 
be reproduced in any form without the prior written permission of KernelApps Private Limited. No 
Patent Liability is assumed, however, with respect to the use of the information contained herein. 

© KernelApps Private Limited. All rights reserved. 

8.2 Trademark 

KernelApps ® is a copyright work of NUCLEUS DATA RECOVERY.COM. 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP® and MS-DOS are registered trademarks of 
Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

8.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. KernelApps Private Limited provides no warranty with regard to this manual or 
any other information contained herein and here by expressly disclaims any implied warranties of 
merchantability or fitness for any particular purpose with regard to any of the foregoing KernelApps 
Private Limited assumes no liability for any damages incurred directly or indirectly from any technical or 
typographical errors or omissions contained herein or for discrepancies between the product and 
the manual. In no event shall KernelApps Private Limited, be liable for any incidental, 
consequential special, or exemplary damages, whether based on tort, contract or otherwise, arising out 
of or in connection with this manual or any other information contained herein or the use there of. 

8.4 License Agreement 

Kernel for ZIP Copyright © by KernelApps Private Limited 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing 
this software, unless you have a different license agreement signed by KernelApps Private Limited. 
The terms and conditions of this License describe the permitted use and users of each Licensed 
Copy of Kernel for ZIP. For purposes of this License, if you have a valid license, you have the right to use 
a single Licensed Copy of KernelApps. 
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Scope of License 

Each Licensed Copy of Kernel for ZIP may either be used by a single person or used non-simultaneously 
by multiple people who use the software personally installed on a single workstation. All rights of any kind 
in KernelApps, which are not expressly granted in this License, are entirely and exclusively reserved to 
and by KernelApps Private Limited. You may not rent, lease, modify, translate, reverse engineer, 
decompile, disassemble, or create derivative works based on, KernelApps, nor permit anyone else to do 
so. You may not make access to KernelApps available to others in connection with a service bureau, 
application service provider, or similar business, nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for ZIP, and any and all accompanying software, files, data and materials, are distributed 
and provided AS IS and with no warranties of any kind, whether expressed or implied. In particular, there 
is no warranty for the quality of data recovered. You acknowledge that good data processing procedure 
dictates that any program, including KernelApps, must be thoroughly tested with non-critical data before 
there is any reliance on it, and you hereby assume the entire risk of all use of the copies of 
KernelApps covered by this License. This disclaimer of warranty constitutes an essential part of this 
License. In addition, in no event does KernelApps Private Limited authorize you or anyone else to 
use Kernel for ZIP in applications or systems where Kernel for ZIP failure to perform can reasonably be 
expected to result in a significant physical injury, or in loss of life. Any such use is entirely at your own 
risk, and you agree to hold KernelApps Private Limited harmless from any and all claims or losses 
relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, 
and merges and supersedes all other or prior understandings, purchase orders, agreements 
and arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction 
and venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, 
and you consent to such jurisdiction and venue. There are no third party beneficiaries of any 
promises, obligations or representations made by KernelApps Private Limited herein. 

Any waiver by KernelApps Private Limited of any violation of this License by you shall not constitute, nor 
contribute to, a waiver by KernelApps Private Limited of any other or future violation of the same 
provision, or any other provision, of this License. 




